Inserting and Editing Pictures in Dreamweaver 8
Terminal Objective: To insert and edit an image into Dreamweaver 8.

Information: If you have already inserted your image, go to page 3 to begin the process of
modifying your picture.

Before inserting a picture in Dreamweaver, be sure that you know where your picture is
located on your computer or on your flash drive.

e Toinsert a picture on an evidence page, first open the evidence page you want to

work on.

e Next, click on the “Insert” Menu and select the *Image’ file option

fe Edt View gggd Modfy Text Commends Ste Window Help

Taq... Chr+E = ks .
C b - 3 = =
e~ gy & B B 0B &
B oge Objects - —
UBEE  Media » :
(o] Code ]ﬁ Table ClrkHAl+T |Bd 8% 8 @, C BB
! Teble Objects , P00 30 400 20 = E50 660 650
Layout Objects R R e A
Form ’
es here
Hyperlink N ) ) ) ) - ) ) )
Lo he text in this window and insert evidence.
Server-Side Include
Comment A . , ’ ; ;
ution setting of 72 dp1 and save at a maximum width of 700 pixels
: HTML »
. Besure Template Objects * lest acceptable file size using Photoshop "File>Save for Web" or )

F Recent Snippets

Ciiekamize Faurrikes

¥ nimizes download time and increases efficient function of the web



e The “Select Image Source’ box will appear. Navigate to the location of your
picture file, which will option be stored on your flash disk.
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e Press ‘OK’




The picture you selected will appear in the Dreamweaver screen.
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Modifying Your Image

Information: Modifying your image or picture can be done for the following reasons:

X3

¢

Faces need to be blurred
Picture needs to be cropped(To crop an image means you want to keep part of

the picture but not all of it)
s+ The file size of the picture is too big(above 40k) or the physical dimensions of

the picture are too big
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e To begin editing your picture, single left mouse click the picture. A thick,
black line will appear around the picture once you have selected it.
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e Looking on the ‘Properties’ bar, which is located at the bottom of the screen,
single click the Fireworks Icon. This icon looks like a little, orange circle.
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Properties window Single click this icon

Clicking this icon will open the picture in a new program called Macromedia Fireworks.
Macromedia Fireworks is a program that allows you to edit your picture.

After clicking on the orange Fireworks icon, the following screen will appear asking if
you want to use a PNG file.
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Do wou wank to use a Fireworks PNG as the source of "tinkype_b-8.jpg”, —
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e Single click the *Use This File’ button. Depending on the version of
Macromedia Fireworks you are using, the buttons may say ‘Yes’ or ‘No.” If
this is the case, press the ‘“No’ button



The picture will open into a new screen that looks like this:
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Face Blurring

You may have some pictures with the faces of your students in them. It is a school and
government requirement that you blur the faces of your students since they are minors.

e To begin the face blurring procedure, single click the icon on the left side of
the screen that looks like a water drop. It is located in the icon group under
the word *Bitmap.’
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Click on this icon

Your cursor will now look like a blue circle instead of an arrow

Once you select this icon, look at the ‘Properties’ menu at the bottom of the screen. You
will see options to change the size of your blur tool(this will allow you to blur a larger

area) and to change the intensity of the blur tool(the intensity of the blur tool determines
how dark or light the blurring becomes).

The size option
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e To make the size of the blur tool bigger, click on the icon next to the number
and adjust accordingly. Increasing the number will enlarge the blur tool so
that you may blur a larger area.

e To change the intensity, click on the icon next to the number and adjust
accordingly. Increasing the number of the intensity tool will blur and darken
an area faster than a smaller intensity.

Click on this icon to change the size of the blur tool
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Click on this icon to change the intensity of the blur tool

An example of a picture with a blur tool set at 75 for size and the intensity set at 80
would look like this:




Once you are done blurring the faces of your students, click on the ‘Done’ button
at the top left of the screen.

| cﬁ’ f.Driginall. B Preview [T]2-Up FH4-Up
a Editing from Dreamweaver

Clicking the “‘Done’ button will close Macromedia Fireworks and put the new picture in
Macromedia Dreamweaver.
[ ]

To see the changes to your photo in Dreamweaver, click the purple ‘Refresh’
button located near the bottom, left side of the screen.
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You MUST click on the purple icon to see the changes you made in your picture.
Picture Cropping
Cropping an image means that you want to use part of an image but not the entire image.

e To crop a picture, first select the picture and press the orange ‘Fireworks’ icon on
the ‘Properties’ menu.
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After clicking on the orange Fireworks icon, the following screen will appear asking if
you want to use a PNG file.
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Firewarks source files:
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¢ Single click the ‘Use This File’ button. Depending on the version of
Macromedia Fireworks you are using, the buttons may say ‘Yes’ or ‘No.” If
this is the case, press the ‘“No’ button



The image will open in Macromedia Fireworks.
e Look at the left side of the screen and pick the fourth icon. The icon you want
to select is directly under the white arrowhead. This icon represents the Crop
tool.

Select this icon
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e Decide which area of your photo you want to crop out of the existing image.

e Place the Crop tool at the left, top corner of the area that you want to crop and
single, left click your mouse and hold the button down.

e Holding the mouse button down, drag your mouse to select the area of the
image you wish to keep. As you move your mouse down and to the right, a
box will appear.



¢ Drag this box to cover the area you wish to keep in the photo. Anything within
the square, highlighted area will be kept.
e For this example, the are being cropped appears below:



O
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The area you highlighted is the area that will be saved but anything outside the
highlighted box will be deleted.

e Once the area you wish to keep is highlighted, let go of the mouse button and
press ‘Enter.’




The part of the image you selected will remain.
Once you are done cropping your picture, click on the ‘Done’ button at the top

[ ]
left of the screen.
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Clicking the “‘Done’ button will close Macromedia Fireworks and put the new picture in
Macromedia Dreamweaver.

To see the changes to your photo in Dreamweaver, click the purple ‘Refresh’
button located near the bottom, left side of the screen.

Click on the purple icon
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Changing Image Sizes

Editing the size of an image too big for an evidence page is a common task when
working with the electronic portfolio. Changing the size of an image requires the use of
Macromedia Fireworks to edit sizes.

e Toinsert a picture on an evidence page, first open the evidence page you want to

work on.

e Next, click on the “Insert” Menu and select the *Image’ file option
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The “Select Image Source’ box will appear. Navigate to the location of your

picture file, which will option be stored on your flash disk.
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The picture you selected will appear in the Dreamweaver screen.
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e To begin editing your picture, single left mouse click the picture. A thick,
black line will appear around the picture once you have selected it.
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e Looking on the ‘Properties’ bar, which is located at the bottom of the screen,
single click the Fireworks Icon. This icon looks like a little, orange circle.
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Properties window Single click this icon

Clicking this icon will open the picture in a new program called Macromedia Fireworks.
Macromedia Fireworks is a program that allows you to edit your picture.

After clicking on the orange Fireworks icon, the following screen will appear asking if
you want to use a PNG file.

Find Source [')_(|
Editing "tintype_b-8.jpg", | Ues 5 PHG |
Do wou wank to use a Fireworks PNG as the source of "tinkype_b-8.jpg”, —
ar edit this image File directly? [ IJze This File ]

To set a preference for the Future, choose an action belaw,

Firewarks source files:
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e Single click the *Use This File’ button. Depending on the version of
Macromedia Fireworks you are using, the buttons may say ‘Yes’ or ‘No.” If
this is the case, press the “No’ button



The picture will open into a new screen that looks like this:
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It is pretty apparent that the image is much too large to be of any value. This picture
would look much better if the whole picture could be seen at one time.



To reduce the size of the picture, locate the ‘“Modify’ menu option at the top of
the screen and single click it. Then choose the *‘Canvas’ option.
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o After selecting the ‘Image Size’ option, the following box will appear

Pizel dimensions
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| QK | | iZancel

The picture above will be used to modify the size of your picture. Two of the fields on
the ‘Image Size’ box are important to look at.



o First look at the field to the right of the word: ‘Resolution.” Make sure that the
number in this box is 72. If it is not, change the value to 72.

Be sure the value in this box is 72
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e The second box to locate at is the top field right under ‘Pixel Dimensions.’

Image Size

Pixel dimensions

— | |F‘ixels V|
IE

1|74 | |Pixels v|

Print size

| 13.194 | |Inches v 7.
]a

1 10,194 | |Inches v|

Resaolukion: | 72 | |Pixels,|'1nu:h v|

Conskrain proportions
Resample image | Bicubic v

[ Ok, ] [ Cancel ]




e Change the value in this field to a value of 700 or less. Sometimes it is not
necessary to have a value as large as 700. If the image is still too large, adjust
the size of the image by following these same steps.

Type in a value of 700 or smaller in this field
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e Press the ‘OK’ button.



The image now should be a size that you can see the entire picture on the computer
screen at one time.
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e After choosing the correct size for your image, click the ‘Done’ button at the
top, left corner of the screen.
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Clicking the ‘Done’ button will close Macromedia Fireworks and put the new picture in
Macromedia Dreamweaver.

To see the changes to your photo in Dreamweaver, click the purple ‘Refresh’
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button located near the bottom, left side of the screen.

Click on the purple icon
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**You MUST click on the purple icon to see the changes you made in your picture.



